
NAVAL ARCHITECTURE
DEPARTMENT OF VEHICLE ENGINEERING

ROYAL INSTITUTE OF TECHNOLOGY

Stockholm
1994

TRITA-FKT
Report
ISSN 1103-470X
ISRN KTH/FKT/SKP/FR--94/50--SE

Theoretical Seakeeping Predictions
On Board Ships –

A System for Operational Guidance
and Real Time Surveillance

by

Mikael Huss and Anders Olander



Theoretical Seakeeping Predictions On Board Ships –
A System for Operational Guidance and Real Time Surveillance

by

Mikael Huss and Anders Olander

ISSN 1103-470X
ISRN KTH/FKT/SKP/FR--94/50--SE

November 1994

NAVAL ARCHITECTURE
DEPARTMENT OF VEHICLE ENGINEERING

Address: Visiting address Telephone Fax

Naval Architecture
Dep. Vehicle Engineering
Royal Institute of Technology, KTH
S - 100 44 Stockholm, Sweden

Dr. Kristinas väg 33A Secr: +46 8 790 7521
Swich: +46 8 790 6000

+46 8 790 6684



Theoretical Seakeeping Predictions On Board Ships –

A System for Operational Guidance and Real Time Surveillance

by Mikael Huss and Anders Olander

Abstract

A prototype of an on board based guidance and surveillance system for wave-

induced effects on ships has been developed. The system includes a complete

model of the ship for direct hydrostatic and hydrodynamic analysis of arbitrary

operating conditions. The sea state is evaluated from measurements of the ship

motions. Criteria for warnings of non-desired events can be initiated on board.

The system can work as an automatic real time monitoring system which will

alert the bridge officer when risk levels are exceeded. At the same time advice

can be given on changes of speed and heading that will decrease the risk. The

system can also be used in a manual mode for analysis of forthcoming situations

in order to optimise the operation of the ship.
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1  Introduction

Due to commercial competition and the general technical development, ships are

continuously becoming more and more optimised toward their economic – or for

naval ships operational – design targets. These targets can be formulated in

terms of low cost, large cargo capacity, efficient cargo handling, high speed etc.

The relative weight between the different targets varies dependent on the type of

ship being designed, but in general, this continuous optimisation leads to a

slowly drift towards the physical limits of a ships capability. At the same time

the society requires increased safety of lives and environment. The only way to

match these two trends is to increase the knowledge of ships behaviour and

potential hazards and assure that this knowledge is used in the design process

as well as in the operation of the ship.

In the last decade the development has led to a number of new ship concepts,

large double hull tankers, hatchless lo/lo containerships and large passenger

catamarans, only to mention a few of the most spectacular. It has also led to a

more extensive use of light-weight material such as very high tensile steels,

aluminium and FRP-sandwich. In parallel to this there has also been important

changes in legislation and international codes. The large classification societies

have developed new ship design rules with more attention to corrosion, dynamic

loading, fatigue strength and to inspection and maintenance.

It is a question at issue whether the technical development has led to over all

safer shipping activities or not. A large part of marine accidents can be derived

to older ships but there are also some indications that new design concepts are

very close to – or even passed – reasonable safety limits. Recent examples can be

found in the capsizing of ferries and ro/ro cargo ships or in the structural

damages of new VLCCs. Without doubts, the management and operation of non-

conventional and highly optimised ships must be put on focus to maintain or

increase the level of safety.

The operation of a ship includes numerous activities such as loading and

unloading cargo, lashing, ballasting, navigation and manoeuvring. The overall

seaworthiness of the ship is the combined effect of the ships inherent
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characteristics and the operational activities on board, which are the

responsibility of the ship master. In moderate sea, with well working equipment

for navigation and manoeuvring, and with a broad knowledge and experience

this task can be sufficiently handled. However, in hard or extreme weather

condition the decision-making on board is by necessity made on the base of

assumptions of the best solution rather than on knowledge and experience of the

actual outcome of the situation.

At the division of naval architecture, KTH, we have for some years been involved

in research activities concerning ships behaviour in waves. This includes

calculation of motions and manoeuvring, /1/, combined wave-induced hull

stresses, /2,3,4,5/ and stability in waves /6,7,8,9/. We have also been engaged in a

few marine accident investigations /10,11,12/. From this experience, the

following crucial points concerning the practical knowledge of ships dynamic

behaviour, have been identified:

• It is not possible to summarise a ships seakeeping characteristics

in just a few general parameters.

• The hull form, the operating condition and the short-term sea

condition are all of vital importance. The ships dynamic response

might be very sensitive to small changes in just one of these.

• Critical situations can appear suddenly without previous signals

of warnings in the behaviour of the ship. 

• It is impossible for a ships master to quantify the risk levels or

safety margins of the ships dynamics in a certain operating

condition. It is therefore also difficult to make rational decisions

about changes in the condition in order to increase the safety.

These points leads to the conclusion that it would be of benefit both for the safety

and for the operability of ships if a ’seakeeping control equipment’ could be at

hand for the decision-making on board. 

The safety consequences of optimised ships is clearly highlighted by

Francescutto in an excellent paper, /13/, from which can be quoted: ”... the design
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of a safe ship cannot be efficiently approached by semi-empirical means and in

some respect it is more complicated than aeroplane design”. ”Probably the loss of

’feeling’ of the masters due to the abandoning of the long time ’tested’

conventional forms has been excessively stressed in recent times”.”The

conclusion is that the only way to overcome the many difficulties lies in the

development of a system for the time domain simulation of ships motions in a

seaway, including a detailed description of the environment and taking into

account the non-linearities present ...”.

This report describes the development of a prototype of such a computer-based

guidance and surveillance system that will make theoretical predictions of the

ships behaviour in waves. The main purpose of the system is to give the

operators information of risk levels of non-desired events caused by the present

sea state. The system presented here is certainly not the final solution, but

rather a platform on which new results from research can be put into practice. 

2  Seakeeping predictions – how, why, when and to whom?

This chapter gives a general introduction to how prediction of ships dynamics is

performed and to which purpose it is used. It emphasise the possible advantages

of making such predictions on board in complement to those made during design.

The well informed reader who is eager to find direct information on the

surveillance system is recommended to continue directly to Chapter 3.

2.1  Models for the random nature of the sea

Before it is possible to discuss seakeeping and ships responses to waves, we must

define a general model for the character of the waves themselves. For our

purpose, this model does not have to describe how waves are generated from

wind, tide, atmosphere pressure etc. (an extremely difficult task even for

meteorologists with super computers). It should only give us information on what

could be expected in a certain already existing sea condition.
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If the sea surface elevation (t) is measured at a fixed position in the sea, we will

find that the time series of the variation is more or less irregular and it is

impossible to foresee exactly where the surface level will be in say two minutes

from the last measurement. The waves appear in a random way and can only be

described in terms of statistics. If the measurements continues for a sufficiently

long period we will find that the variation around the mean surface level (still-

water level) follows a Gaussian- or normal distribution with zero mean and with

a variance 2 (standard deviation ) that is a direct measure of the severity of

the sea state.

Such an irregular wave condition can be simulated with a large number of

regular harmonic wave components superposed upon each other, with different

amplitudes, a i, frequencies, i, and with slowly varying random phase lags i.

  
(t ) = a i cos( it + i )

i
∑

The total energy per surface area of the superposed wave system will be equal to

the sum of the energy from all regular wave components which is proportional to

their amplitudes squared. With statistical theory it can be shown that the

variance of the combined surface elevation is 

    

2 =
a i

2

2
i
∑

The usual way to define a certain irregular sea state is by its energy- or wave-

spectrum S ( ) which describes how the energy of the irregular wave elevation

and propagation is distributed over the wave frequencies.

The properties of the spectrum are such that the surface variance becomes

    

2 = S ( )d
0

∞

∫

and the mean frequency of zero-crossings is
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2 =

2S ( )d
0

∞

∫
2

or more commonly used, the mean zero-crossing period

    
Tz = 2

2

The shape of the spectrum is unique for every single occasion and dependent of

the weather history and geographic and oceanographic properties. The actual

shape is usually not known and in weather reports the sea state is defined by

two statistical properties: significant wave height Hs which is the mean value of

the one third largest wave heights (crest to peak), and the mean period Tz

defined above.

If the energy spectrum is relatively narrow-banded, i.e. the energy is

concentrated to a narrow interval of wave frequencies, the significant wave

height will be

    
Hs = 4.0 ⋅

and the probability of exceeding a certain wave height follows a

Rayleigh-distribution 

    Q(H) = e
− 2⋅H2

Hs
2

The two statistical properties Hs and Tz varies continuously as the weather

changes. The long-term ocean wave statistics gives information of the relative

frequency of these parameters over the years at different ocean areas.

Both the short-term irregular sea description and the long-term wave statistics

are used for seakeeping predictions and for design purposes.
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2.2  Prediction of ship response in irregular seas

Sea waves cause various effects on ships. Important wave-induced effects are:

• Motions

6-degrees of freedom rigid body motions

(shift and damage of cargo, seasickness),

ship-wave relative motions (slamming and green water on deck)

• Structural loads

global hull girder moments and forces (critical for deck and

bottom structure ultimate strength and for fatigue),

hydrodynamic pressure on local structure

• Manoeuvring and other wave-induced (non-oscillating) effects

loss of speed (influence on resistance and propulsion),

changed manoeuvrability (broaching),

changed stability (parametric roll, capsizing)

The combination of all these effects forms the base of a ships seaworthiness.

If – and this is an important if – the ships response to waves is linear i.e. a

double wave height will cause the double response, the response characteristics

in an irregular sea can be described by a response spectrum Sr( ). From this

significant values, mean periods and exceedance probabilities for the response

can be evaluated in a similar way as for the wave spectrum.

    
Sr ( ) = r ( )2S ( )

where r denotes a general linear response and the associated transfer function

r( ) is defined according to

  
r ( ) = r( )

a( )

where r( ) is the response amplitude to a regular wave with frequency and

amplitude a( ).
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Besides the wave frequency, r( ) is a function of the ships geometry and

operational condition, and hence the final irregular response will be a function of

these and of the wave spectrum. Transfer functions for motions and structural

loads can – with reasonable accuracy – be calculated with 2-dim strip theory or

with 3-dim panel methods. After three decades of research and development such

calculations are becoming routine.

In extreme sea conditions hardly any type of response can be treated as linear,

but for most of the sea states (including moderate storms) a ship will encounter,

the assumption of linearity is generally sufficient for wave-induced motions and

structural loads of large ships. (One exception to this is the roll motion where

non-linear damping effects are significant). For the calculation of responses in

irregular seas it is a great advantage when the response can be treated as linear. 

If the response is non-linear, as for extreme wave conditions or for coupled

effects of linear components, the only true way to find the statistics of the

response is to measure or calculate it in a time sequence. Such analyses can be

made by model tests or by time-series simulation with numerical methods on

computers. The first alternative becomes very expensive and limited, and the

latter usually very complicated and time consuming if hydrodynamic properties

must be recalculated in every time-step and the total length of the simulation is

made large enough to get sufficient data for estimating the statistic properties of

the response. Furthermore, the result is only valid for the specific analysed

condition and cannot be generalised in the same way as linear responses. Non-

linear wave response of ships is therefore still mainly a research area and not so

much in practical use for design of ships.

The long-term distribution of wave responses can in theory be obtained by

summing up the distributions of responses to all possible short term sea states,

weighted with their probability of occurrence during the ships life-time service.

The long-term probability of exceeding a certain response value can thus in

principle be written

2  Seakeeping predictions – how, why, when and to whom? 7



  

Q(r) = Qij(r)
j

∑
i

∑ ⋅ pi ⋅ p j

where Qij(r) is the short-term exceedance probability at a certain operational

condition, i, and sea state, j, and pi, pj represent the long-term probabilities of

these.

It is not difficult to imagine the number of terms in this summation if it is done

properly including all possible significant wave heights and wave spectrum

forms, and all possible combination of operational conditions (speed, draught,

heading, GM, cargo distribution etc.). When long-term distributions are

calculated this way, they are by necessity restricted to include linear responses

and only a few conditions and wave spectrum forms.

2.3  Seakeeping predictions during design – constant parameters

As mentioned above, calculations of motions and loads are becoming routine.

How then, can results from such calculations be utilised to optimise the

performance of a ship? Let us first look at the design process.

At the pre-design stage, prediction of ship motions might be an important part of

feasibility studies of different design concepts. Predictions of the the operability

of ferries and passenger vessels should indeed include long-term distributions of

wave-induced motions. For small and fast passenger crafts, the seakeeping

characteristics might be the decisive factor in the choice between a mono-hull,

catamaran or SWATH. Such comparisons are preferably made in few design

short-term sea states, rather than in a long-term summation of all possible

states.

During the preliminary design of a new ship, the concept is usually fixed and the

main task is to find the optimum main dimensions of the ship, i.e. length,

breadth, draught and displacement. When these are settled, they will for the rest

of the design process and for the rest of the ships life act as constant parameters

in the overall characteristics of the ship.
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There are numerous considerations to be made and constraints to be checked

before the final decision of main dimensions. Some examples: for a fixed cargo

capacity, a longer ship will be heavier, and more expensive to build, while it

probably will need less power than a shorter at the same speed. The breadth

might be restricted by channels and by the static stability, and the draught by

harbours. For a conventional merchant ship there is little or no space left to

make the seakeeping performance a governing factor at this stage of the design

process. Some attempts have been made to apply seakeeping merits into the

preliminary design by using systematic data from calculations of different hull

dimensions, and to weight their relative importance in a ’rank index’, /14/.

However, when looking into example results, one can find that the differences in

seakeeping performance for realistic chosen hull dimensions will not be

significant. One reason for this is that the dimensions are not so important (see

fig.2.1), but another reason might also be that a standardised ranking cannot

identify the critical conditions in which the difference in performance becomes

important.

After the preliminary design phase, the hull form and general arrangement is

settled. Here, some minor considerations are often made concerning the wave-

induced motions, e.g. for the bow flare design, but the governing objectives are

others such as low resistance, large deck areas and efficient cargo handling.

The structural design is normally made according to classification rules. In the

rules, long-term wave induced loads are included explicitly for global hull girder

loads and in some way explicit or implicit in the local design loads. Even though

the rules today accept direct calculation of wave loads and strength, the design

vertical wave bending moment, Mw, accepted by the Classification Societies

within IACS is normative, /35/.

    
Mw   [kNm]

= +0.19CbMCL2B (hogging )

= −0.11(Cb + 0.7)MCL2B (sagging )

    

C

= 10.75 − (
300 − L

100
)1.5 for 90 ≤ L ≤ 300

= 10.75 for 300 < L < 350

= 10.75 − (
L − 350

150
)1.5 for 350 ≤ L

Here Cb is the block coefficient, M is a distribution factor (=1 at midship), L is

the ship length and B the breadth in m.

2  Seakeeping predictions – how, why, when and to whom? 9



The formula above refer to a wave-induced bending moment with a long-term

probability level of exceedance in the order of 10-8 . This corresponds

approximately to the most probable largest moment during 20 years sea service.

The IACS formula has been obtained from long service experience and from

analysis of a number of different theoretical calculations of long-term responses.

It includes the non-linear effect of larger extreme sagging moment than hogging

moment.

As formulated, the Mw design moment is only influenced by the main dimensions

of the ship, and not at all by other parameters such as hull form, speed, cargo

distribution or ocean area. It must be emphasised that the Rules Mw is nothing

more than a design value, assuring a kind of minimum acceptable scantling

standard for ordinary ships. The requirement on the midship section modulus is

such that the wave-induced part of the longitudinal nominal stress due to

vertical bending moment always should be maintained below 110 MPa (for mild

steel).

When the ship is designed, built and delivered, a normal situation is that the

seakeeping calculations are becoming ’dead’ documents, not used or requested by

anyone during the operation of the ship.

2.4  Conditioned seakeeping parameters – environment and load condition

The main dimensions and hull form are built-in parameters that cannot be

changed in order to improve the seaworthiness of the ship. However there are a

number of other important parameters that are coupled to the operating

condition. These conditioned parameters might have a much larger influence on

the ships behaviour, than a strict seakeeping optimisation at the design stage.

Furthermore, they can to some extent be changed in critical situations in order

to increase the safety. 

The most important parameter is of course the environment – the sea state

itself. Even though the ship has been designed to be seaworthy in general terms,

the actual (stochastic) behaviour in a specific situation is directly determined by

the character of the waves. In reality, the sea spectrum might differ significantly

10



from the standard spectra used for design purposes. The influence from wind can

also be significant but is usually not included in prediction models. Although it is

not possible to change the weather and the waves, the ships environmental

condition can be influenced by taking another route. 

Other conditioned parameters that are important for the ships behaviour are

more directly determined by decisions on board:

• The speed and relative heading to the waves

• The centre of gravity

• The distribution and amount of cargo and ballast

Before discussing when changes in these conditioned parameters are taken into

consideration let us identify some non-desired effects and risk factors due to

wave-induced motions and loads:

Examples of non-desired wave-induced effects:

• Seasickness of passengers and crew

• Damage on cargo due to large accelerations

• Local structural damage to forward structure due to slamming,

wave impacts and green water on deck

• Shift of cargo due to a combination of roll and accelerations

• Parametric excitation of large roll motions

• Loss of stability in following waves

• Hull girder collapse due to extreme wave-induced loads

These examples are chosen to illustrate the variety of problems that can be faced

in a severe sea condition. The first three of them are possible to identify on board

2  Seakeeping predictions – how, why, when and to whom? 11



and the problems increases continuously as the sea grows higher. The last four

however, are more of threshold character and might occur without previous

warnings. Especially for these type of effects, there would be a large advantage

to have an automatic prediction system on board in order to guide the decision-

making.

2.5  Operational decisions to reduce risk

Operational considerations governed by wave-induced risk effects are made at

different times. 

• Pre-operation decisions includes considerations taking at harbour.

For a passenger ship the question might be whether to sail or to

stay at quay.

• Preventive decisions are taken continuously during operation to

avoid situations that might be uncomfortable or hazardous. It

includes weather routeing, i.e. to change the route in order to

avoid difficult sea conditions. For a cargo ship it could also be a

question of extra lashing or ballasting before entering heavy sea.

• Heavy weather manoeuvring are decisions taken when actually

caught in a severe sea. The only way to affect motions and loads

in this situation is usually to change the relative heading and

speed of the ship.

It is obvious that if predictions of the forthcoming wave-induced effects can be

made early and reliable, the operation of the ship can be made safer and better

optimised. Unfortunately the situation today is that no guidance is given and no

quantitative predictions are made for this purpose on board. The experience of

the officers is very important, but according to our opinion many of the wave-

induced effects cannot solely be managed by experience. This has been the prime

motive for our development of an on board based operational guidance and

surveillance system for ships dynamic behaviour in waves.

12



2.6  Examples of parameters governing the seakeeping performance

A few figures are included here in order to illustrate the previous discussion.

They show typical examples of influence from different constant and conditional

parameters on ships seakeeping characteristics. Figures 2.1-2.3 are based on

systematic calculations of the vertical acceleration at the forward position on

main deck of a dry cargo ship. The results all refer to the same ship sailing in a

short-term sea state with 6m significant wave height.

The main particulars of the reference ship are:

Length between pp 212.3 m

Maximum breadth 32.2 m

Draught 8.0 m

Block coefficient Cb 0.67

Displacement in SW 37440 ton

Metacentric height, GM 1.5 m

In Fig.2.1, the influence from the constant parameters length, breadth and

draught is illustrated. The length and breadth are systematically varied while

the draught is adjusted to comply with constant displacement and block

coefficient. Even though the variation of main dimensions are extremely large,

the results shows only a moderate influence on the significant vertical

acceleration at this specific sea state.

2  Seakeeping predictions – how, why, when and to whom? 13



Fig.2.1 Example of influence from varying main dimensions on the vertical
acceleration on forward deck. Bow sea, Hs = 6 m, Tz = 8 s, 15 kn
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Fig.2.2 illustrates the influence from operational decisions, changed course and

speed in the same sea state as used for Fig.2.1. In this specific example one can

see that the operational decisions are much more important than any decisions

taken during design concerning the main dimensions of the ship.

Fig.2.2 Example of influence from changed relative wave direction and ship
speed on the vertical acceleration on forward deck. Hs = 6 m, Tz = 8 s

2  Seakeeping predictions – how, why, when and to whom? 15



Fig.2.3 is the last in this series. It illustrates the influence from wave spectrum

form on the response. The previous two figures have been prepared on the basis

of response in an ordinary sea spectrum of the Pierson-Moskowitz type with a

rather wide distribution of wave energy over the frequencies. In the last figure,

instead a more general 6-parameter spectrum formulation according to Ochi, /34/

has been applied. With this spectrum it is possible to model mixed seas including

swell and new developed wind waves. Such conditions usually have two peaks,

one for the swell energy at lower frequencies and one for the wind waves with

energy at higher frequencies. The figure shows that in this example there is a

significant influence from the mean period of the wave spectrum as well as from

the form of the spectrum. This influence is however not so large as the influence

from possible operational decisions shown in Fig.2.2.

Fig.2.3 Example of influence from spectrum form on the vertical acceleration
on forward deck. Bow sea, Hs = 6 m, 15 kn

16



The final of the example figures is taken from /3/. It shows the influence from

wave direction on the wave-induced longitudinal stress in the bottom girder of a

50000 tdw OBO-carrier (length 200 m). The stress response in this case is the

combined effect of vertical- and horizontal hull girder bending moments, local

hydrodynamic sea pressure and inertia force from the oil cargo. Hold 5 is the

midship cargo hold, and the figure includes the distribution of stresses in this

and the three forward holds. Wave direction 180° is here equal to head waves

and 0° is following waves. The large influence from relative wave direction on the

structural loads is clearly shown in the figure.
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3  Properties of a guidance and surveillance system

On the basis of the previous discussion, it is possible to identify a number of

properties that should be included in a guidance and surveillance system. Some

of these properties are included in the prototype described in Chapter 6 while

others are still at a stage of development.

3.1  State of the art

There are today several existing commercial surveillance systems based on

measurements of some characteristic wave-induced effect, usually accelerations

or deck strains. From the statistics of the last records, these systems can

continuously make predictions of significant values and maximum values of the

measured response, and warnings can be given when preset limits are exceeded.

The development of rationally based on board prediction systems started in the

1970:s when the statistical models of the nature of random seas and wave-

induced hull girder loads had been verified by calculations, model tests and full

scale measurements. An important reference from this time is the thorough

paper by Lindeman et al from 1977, /15/, in which both the wave load and the

structural capability are treated with probabilistic methods. At the end of that

paper, the authors express that they believe that making hull surveillance

systems mandatory on certain types of ships would considerably improve safety

and effectiveness at sea.

Today such systems have yet not become standard equipment. The large

majority of ships are still sailing without any kind of real time operational

guidance concerning wave-induced effects. The conditions are however rapidly

changing now. The capability and reliability of measuring equipment has

increased significantly and the cost of electronics and computer analysis

continuously decreased. Some Classification Societies now have introduced a

special class notation for ships with hull surveillance systems installed on board.

An overview of the research carried out by Lloyd´s Register of Shipping in this

field is presented by Robinson in /16/. Four different type of monitors are

identified which would enable ships to be operated efficiently within their design

limits:
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• Seakeeping monitor

Display of motions, Evaluation of wave height and period from

motions, Advice on optimum ship speed/heading with respect to

passenger/crew comfort and heavy weather damage, Post voyage

analysis

• Loading and structural monitor

Display of still-water and wave-induced stresses, accelerations,

impact loadings, Advice on optimum speed/heading, Post voyage

analysis

• Machinery and fuel performance monitor

Display of shaft power, rpm, fuel consumption, Display on

optimum maximum speed/heading to reduce fuel consumption,

Post voyage analysis for future voyage planning, machinery

maintenance and long term degradation

• Environmental monitor

Display of current environmental values (wind, temperatures,

barometric pressure, water depth, calculated sea state), trends of

deteriorating conditions

The prime motive for most of todays existing surveillance systems is the

structural safety. A typical configuration consists of deck strain gauges to

measure the longitudinal hull girder bending stress and an accelerometer

positioned close to the ships forward end to measure bow impacts and slamming,

/17/. An example of such a system is the Structural Monitoring System (SMS)

developed by Ship & Marine Data Systems Ltd, /18/. It is a ’passive’ system in

the sense that it displays only measured records and trends, and makes no

analysis of what would be if conditions are changed. The records can however be

stored and analysed ashore for long term planning purposes. A comprehensive

structural management strategy for BP Shipping VLCCs is described in /19/. It

includes analytical studies to identify critical structural locations and load

conditions, inspection schedules and staff training, on board measurements and

displays and feedback from inspection, testing and monitoring records.
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Fig.3.1 Layout of the structural monitoring system adopted for BP VLCCs
with flow diagram analysis of full scale data, from /19/.

Besides strain monitoring, several systems have been developed that uses

motion measurements to survey operational requirements on the security of

cargo, comfort and stability, e.g./20/, /21/. The Ship Structure Committee

initiated in 1985 a project to develop a generalised on board response monitoring

system that would have application on any vessel. In the first report 1990, /22/ a

review of 24 previous full scale response monitoring projects was presented.

However, most of these were research efforts rather than standard

instrumentation.
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In the following sections we will briefly discuss the properties that have been

identified as being the most important in a guidance and surveillance system.

3.2  Theoretical procedures for predictions and simulations

If a surveillance system should be able to warn about high risk levels and at the

same time give guidance about operational decisions, it must be able both to

identify the present situation and to model any other situation that will arise

after the condition is changed. This implies that the predictions should be based

on theoretical models rather than on pure measurements.

Systems solely built up around measured data can be useful as indicators, but

the draw-backs are obvious. Only the measured response can be accurately

predicted, and no guidance whatsoever can be given on what will be the best

action to decrease the risk. Furthermore, when record-based systems report

dangerous response levels, it might already be to late to make any dramatic

change in the condition. In a theoretically based system these problems can be

solved and the main issues instead become to establish a reasonable accurate

mathematical model of the ships behaviour and to determine the actual sea state

in which the ship is – or will be – operating.

The key points in a theoretically based system are:

• Knowledge of the ships operational condition

• Methods to establish the sea state

• Linear response calculations in the frequency domain

• Time series simulations of non-linear response

• Statistical models to establish risk levels of non-desired events
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In communication with the system interface, ship officers should be able to:

• Automatically receive warnings of pre-defined risk events

• On request receive guidance on operational decisions

• Change any of the conditioned parameters in order to analyse

alternative conditions

• Modify risk events and criteria for warnings

3.3  Determination of the sea state

In a theoretically based surveillance system, all predictions of responses and risk

levels are based on a description of the wave spectrum (present or forthcoming).

The results can never be more accurate in statistical terms than the accuracy of

the spectrum formulation.

For qualitative analyses and pre-operational predictions, it might be sufficient to

use data from weather reports. In this case usually only wave direction,

significant wave height and mean period are available and standard

assumptions must be made for the spectral form. Possibly in the future, the wave

data will become more detailed and response predictions more reliable.

For quantitative analyses and in-situ risk level warnings, the wave spectrum

should be determined in more detail than can be achieved from weather reports.

When a high level of accuracy is wanted, some sort of wave measuring must be

performed on board the ship. The following Chapter 4 describes one such method

that we have adopted in the prototype – to use measurements of the ship

motions to identify the wave characteristics. There are also other possibilities

such as wave measurements with pressure gauges, radar or laser, or perhaps in

the future even with satellites. Important factors that should be determined are

mixed swell and wind waves, multi-directionality, spectrum bandwidth, etc. To

some extent these wave characteristics might be observed and given as input by

the officers, but solely visual information will not be sufficient.
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3.4  Measurements

In principle, a theoretically based system can work without any measurements

of the ships behaviour at all. When all predictions are performed with computer

simulations the quality of the results is a function of how well the operating

condition is defined, and on the quality of the computer model. There are

however, a number of weighty arguments to include also continuous

measurements into the system, not as the prior base of predictions but rather as

a control of the validity of the theoretical models and the assumed condition.

Important feasibilities of real-time measurements in a theoretical system are:

• Changes in the operating condition can be automatically

discovered without input from the operator

• Theoretical simulations can be calibrated (adaptive systems)

• The sea condition can be evaluated (see Chapter 4)

• Records from measurements can be saved in a ’black-box’ and in

an electronic logbook

A major part of the hard- and software installation cost of a system on board will

be coupled to the measurement equipment. In order to get a cost efficient system,

measured parameters must be carefully chosen and tailored for the purpose of

the specific ship. For a large tanker or bulk carrier, hull stresses might be the

most critical wave-induced effect while the combined accelerations on cargo

decks might be critical for the lashing system on Ro/Ro ships. To decrease the

uncertainty in the theoretical predictions, the results should of course preferably

be calibrated with measurements of parameters that are correlated to these

critical effects. Such parameters can be deck strain and accelerations

respectively, but it might also be the case that the most critical uncertainty for

both these effects are the determination of the wave spectrum and hence it

would be more efficient to choose measurements that are optimised for this

purpose. 
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The prototype MONITOR described in Chapter 6, is for general purpose designed

to use measurements of the ship motions at an arbitrary position in the ship.

With this configuration the gauge unit can be installed at the bridge, and

installation costs can be kept at a minimum. This basis configuration can then be

expanded according to other specifications.

3.5 Warnings and operational guidance

The main purpose of a system for prediction of wave-induced effects is to present

information in a way that can be used for operational decisions. The uncertainty

in calculation models is still so large that it cannot be justified to let the system

directly influence the operation, instead it is to be used as one of several sources

of information. The major advantage of theoretical models is that they make it

possible to predict critical situations with a very low – but still significant –

probability of occurrence. Such situations can usually not be handled with

experience based knowledge, and there exists no general accepted criteria to

which the predicted risk levels can be compared. A computer based system

should therefore be part of a total risk analysis strategy, in which different

hazardous situations are identified and the consequences are studied in order to

develop relevant criteria for safety. These criteria are then triggers for the

warning signals in the surveillance system.

As an example, one such important criteria for the risk of shift of cargo, is the

effective heel angle, i.e. the combined effect of roll motions and accelerations in

the vertical and transverse direction. If the cargo securing system is designed to

be effective up to a certain static angle of heel, this angle (reduced with an

appropriate safety factor) can be compared with the present probability

distribution of the effective heel in operation. The effective heel criteria is

further discussed in Chapter 5.

Since low risk-levels are difficult to judge and understand, they should in the

warning interface be translated into physical, graspable units. The

trustworthiness of given warnings will increase if the trigger levels will be

possible to identify on board. Instead of using high level amplitudes with a very

low frequency of occurrence it is preferable when possible, to use lower

amplitudes with measurable frequencies as criteria.
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When a warning is given, the system shall also deliver advice of which action to

make to decrease the risk in question. The only available immediate actions are

changes of speed and course but it should also be possible to investigate the

effect of changed trim and ballast condition. When the system is used at harbour

to simulate a forthcoming voyage, the number of possible actions will of course

be much larger including also the alternative to stay at quay.

In this report we have by purpose left out one of the most important parts of a

guidance system – the formulation of relevant criteria for wave-induced effects.

The reason for this is that criteria are difficult to generalise but should according

to our opinion preferable be identified and quantified within the total risk

analysis of the ship. The system configuration and functionality can be treated

as rational and objective while the accepted risk levels by necessity includes a

large part of subjectiveness. 

3.6  Adaptability to different ships and conditions – a platform for education

Another important feasibility of a guidance system based on theoretical

predictions is that it can be used on shore to compare the characteristics of

different ships, conditions, sea states, lashing systems etc. With an interface

designed to give information of the most important risk levels it will be much

closer the real situation on board than standard seakeeping programmes

presenting numerous diagrams and tables of response operators. After a few

days of preparation and training, ship officers would be much better acquainted

with the dynamic characteristics of a new ship than they ever could be by

reading design reports.

At the ship owners office a PC with copies of all ship data files including sets of

pre-defined loading conditions can serve as a base for discussions with the ship

master when certain operational decisions are necessary. This does not mean

that the responsibility of the ship are to be moved away from the master, but

rather a way of spreading knowledge within the organisation.
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3.7  Other possibilities

In the previous sections we have discussed what we think are the most

important feasibilities of a surveillance system. These have been the foundation

for the development of the prototype described in Chapter 6. In addition, one can

imagine a number of other possible advantages of having such a system on

board, especially if it includes real time measurements. If the system is working

continuously (not necessary with the interface active), the analysed data from

measurements and theoretical predictions can be stored and used for following-

up of the ships long-term history of loading conditions and sea states. Together

with recorded navigational data such as power output, speed, heading and

position, it could be a valuable database for the planning of surveys and even for

the design of a new generation of ships. Full scale measurements and experience

from surveys is the most important basis of Classification Societies rules for

structural design. With automatic voyage data recording of ship dynamics,

experience could be used in a much broader sense for the design of ships with

better operability. Voyage data records could also be stored on board in a ’black

box’ system for retrospective analysis of accidents.

Another possibility is of course to use the system for speed optimisation and

weather routeing. On board based weather routeing incorporating the

seakeeping characteristics of the specific ship has several advantages in

comparison with traditional on shore based routeing services, /23/, /24/:

• The influence from actual ship condition can be better taken into

account

• With a complete ocean environmental forecast information from

the meteorologists, the ship master is free to examine different

possible routes and select the best with respect to the most

important criteria for that specific voyage

• Environmental forecast information can be updated by wave

measurements on board and reported back to the meteorologists
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4  Wave estimation through ship motion measurements

4.1  The direct method

A very important part of a seakeeping surveillance system based on theoretical

predictions is to achieve sufficient accuracy in the description of the sea

condition. Unfortunately often only limited information is available on the

environmental conditions by meteorologic reports. The emphasis is often on wave

heights rather than wave periods, and information on directionality and wave

spectrum forms are rare, /25/. At an early state within this research project it

was therefore identified as a key issue to include some sort of automatic sea

state evaluation in the system. The reason for this was twofold, the prediction of

risk levels must be quantitatively as good as possible and the system must be

able to work without manual input. On the other hand it was also clear that the

hardware equipment – at least on the prototype – should be easy to install and

based on standard components. 

Within these constraints, it was decided to use motion measurements on the ship

as input for the evaluation of the sea condition. In theory this is a straight-

forward method. Chapter 2 included a description of how response spectra in

principal can be calculated from transfer functions and a known wave spectrum:

    
Sr ( ) = r ( ) 2S ( )

Consequently, if a response spectrum is measured and the transfer function

known through theoretical calculations, the wave spectrum can be evaluated:

    
S ( ) =

Sr ( )

r ( )2

Although this direct method is straight-forward, there are a number of

difficulties in the practical application:

• The response transfer function must be calculated on basis of a

known relative wave heading 
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• The waves are assumed to be long crested, or to have a known

directional spreading 

• The response spectrum is measured over the encountering wave

frequency, in irregular following waves this is not a unique

function and numerical problems might arise

• Usually a measured response spectrum will only cover a part of

the wave frequency range and wave energy at frequencies with

low response levels cannot be evaluated with sufficient accuracy

4.2  The variation method

In order to avoid some of the problems with direct wave evaluation, especially

the problem with low response levels and numerical problems, pre-defined shape

functions can be used to describe the wave spectrum. The parameters of these

shape functions are to be determined so that the difference between the

calculated response caused by the estimated wave spectrum and the measured

response is minimised.

The wave spectrum description is formulated as a linear combination of shape

functions fn( ):

    
S ( ) = an ⋅ fn ( )[ ]

n=1

N

∑

A variation function F can then be formulated:

    

F(a1, a2 ,, aN ) = r ( )2 an ⋅ fn ( )[ ]
n=1

N

∑ −Sr ( )
 

  
 

  
0

∞

∫
2

d

The best combination of shape functions will yield the minimum value of F. By

derivation, N linear equations are established from which the coefficients an can

be solved. 
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∞
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0

∞
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M

r ( )2 fN ( ) an ⋅ fn ( )[ ]
n=1

N

∑ − fN ( )Sr ( )
 

  
 

  
0

∞

∫ d = 0

The variation formulation has several advantages in comparison with a direct

method:

• Several response measurements can be used simultaneously but

with different weights to achieve a best solution (an ’expert’

knowledge can be adapted to chose the weight factors dependent

on the situation)

• The variation function itself can be used as a measure of how well

the evaluation fits all measured data, and could be included in

the risk assessment

• With a sufficient number of independent measurements, in

principle also the predominant wave heading and directional

spreading function can be solved

• By appropriate choice of shape functions (with physical realistic

properties) numerical problems can be avoided in the evaluation

procedure

• A full wave spectrum can be derived even though measurements

only covers a narrow range of frequencies

It must however be emphasised that the variation method is no ’Colombi egg’

that solves all problems associated with wave evaluation from measured

response.
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4.3  Full scale measurements on PCTC AIDA

In order to test and further improve methods to estimate wave conditions based

on ship motions, full scale measurements have been conducted on the pure car

and truck carrier AIDA during one year of worldwide service. A detailed

description of the measurement equipment is given by Jönsson in /26/.

The ship was equipped with a two-axis roll-pitch rate gyro and an accelerometer

for vertical accelerations. Fig.4.1 shows the main components of the equipment.

Measurements were initiated by the commanding officers on board when the

observed wave height exceeded 2 m. All results were stored on floppy disks

(approximate 4.5 hours of measured data on each) and transferred to KTH via

satellite communication or mail. In addition to the recorded data a short report

was given by the officers including the ship’s condition and the observed weather

and wave characteristics during the measuring period. 

Computer

Terminal
Rate 
gyro

Accelero-
meter

Transducers Floppy disk drive

Signal 
processor

Main  
processor

Navigational system 
on board

Fig.4.1 Main components of the measurement equipment, from /27/

The results were analysed at KTH with the main purpose of identifying problem

areas in full scale wave estimation and to improve the analysis methods which

previously only had been developed and checked towards computer simulated

spectra. A thorough presentation of the results and different evaluation methods
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is given by Hua and Palmquist in a separate report within this project, /27/. This

report also includes a brief survey of other possible wave measuring systems.

Unfortunately there were only few occasions during the full scale measurements

when the sea state was sufficiently severe to give useful records. Therefore, we

have still not enough knowledge and experience to establish the best analysis

method and measuring configuration for wave evaluation. However, the

following general conclusions can be put forward:

• Measurements of pitch motion and vertical acceleration is

sufficient to evaluate head seas with good accuracy as long as the

wave characteristics are fairly long-crested.

• Subsequent short-term spectra evaluated for a period of a few

minutes show a large scatter while mean spectra over a period of

20 minutes shows rather consistent characteristics.

• The uncertainty in evaluation procedures decreases significantly

if observed data such as predominant wave direction and short-

crestedness can be used as input values

• Additional response measurements such as wave pressure and

local structural wave-induced loads could improve the evaluation

accuracy, especially in the high-frequency range

Based on the full scale data from AIDA, the following shape functions have been

chosen to represent evaluated wave spectra in the prototype system:

      

S ( ) = a1 ⋅SPM ( , Tz ) + a2 ⋅SJONSWAP ( , Tz )+K

K+a3 ⋅SPM ( , Tz − 1) + a4 ⋅ SJONSWAP ( , Tz − 1)

where SPM( ,Tz) is an ordinary 2-parameter Pierson-Moskowitz wave spectrum

with unit significant wave height and mean zero-crossing period Tz, and

SJONSWAP( ,Tz) is a mean JONSWAP spectrum originally formulated for the

North Sea. The mean JONSWAP spectrum has a much more narrow peak (peak
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magnifying factor γ=7) in comparison with the PM-spectrum that originally was

based on measurements of fully developed seas in undisturbed ocean areas. The

constant parameter Tz used in all spectrum functions, is the mean period taken

from a prior wave spectrum evaluation using the direct method. 

The above wave spectrum formulation is rather smooth and it allows no extreme

two-peakness in the spectrum form. It has been chosen to fit the available data

from the configuration of the prototype, i.e. pitch and vertical acceleration is

used for wave evaluation. The roll motion which also has been measured on the

full scale trials is generally not suitable for this purpose because of its very

strong resonant character. However, roll measurements can be an important

part of a surveillance system as an indicator of the ship’s stability. 

Figures 4.2-4.4 below shows examples of evaluated wave spectra for one of the

measure blocks recorded on board AIDA. The visual observation at this specific

time was 4 m observed wave height and 12 s observed wave period.
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Fig.4.2 Estimated wave energy spectra from measured spectra of pitch velocity
and vertical acceleration on board AIDA. From /27/
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Fig.4.3 Time history of the estimated significant wave height block by block
under one measurement occasion. From /27/
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Fig.4.4 Time history of the estimated mean wave period block by block under
one measurement occasion. From /27/
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5  Effective Heel

A guidance and surveillance system based on theoretical analysis of ship motions

can be tailored to fit the specific requirements of each individual ship with

regard to wave-induced effects. In the development of the prototype presented in

Chapter 6, we have therefore not included a long menu of different response

presentations and warnings, but instead concentrated the information to the

core results, rigid body motions and their combined effect in terms of

accelerations at arbitrary positions on the ship. However, we have identified and

included one combined, non-linear effect that is critical for most ships – the

’effective heel’.

5.1  Definition of effective heel

The effective heel (also called effective roll angle or lateral force estimator) is a

criterion used to judge the real time combined wave-induced effect of

accelerations and gravitational forces due to inclination at a certain position in

the ship. This effect is critical for the risk of gliding or tipping of cargo (Ro/Ro

ships!), for the strength of the lashing equipment (deck cargo!), and in some

cases also for the strength of internal structural members (Lo/Lo cell guide

systems). It has also been used as criterion for deck personal operations to

evaluate the number of motion-induced interruptions (MIIs) per minute /28,29/.

Cargo shifting is today identified as one of the most critical events for car and

truck ferries and for general Ro/Ro ships. It has been the direct cause of several

total losses and many more serious incidents during the last years. Also the

economical consequence of damaged cargo is significant, and it would be an

important contribution both to the safety and profitability of sea transportation

systems to keep control over the risk of cargo shifting.

From a static point of view, it is possible to identify a critical angle of inclination

–  usually assumed to be the roll angle – at which tipping and gliding will occur.

The governing parameters are here the geometry of the cargo and lashing

system, the strength of the lashing and the friction between cargo and ceiling.

The shift of cargo can appear within cargo carrying units (containers, trailers ) or
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direct to the units themselves.

In a wave-induced dynamic situation, there is no static angle of heel but a

combination of motions, and inertia forces that will cause shift of cargo. This

combined effect can however at a specific time be made equivalent to a static

angle by the definition of an effective heel, (t).

φ

F

F: tangential force

N: normal force

Deck

m(av+g)

m(ah)

N

α

Fig.5.1 The combined effect of gravitation, inertia forces and roll angle gives
an equivalent effective heel

Below is given for motions in the transverse plane.

  

(t ) = arctan
F (t )
N (t )

 
 

 
 

F( t) = m ⋅ av ( t) ⋅ sin( (t )) + ah (t ) ⋅ cos ( (t )) − z ⋅ ˙ ̇ (t ) + g ⋅ sin ( (t ))( )
N( t) = m ⋅ av ( t) ⋅ cos ( (t )) −ah (t ) ⋅sin ( (t )) + y ⋅ ˙ ̇ (t ) + g ⋅cos ( (t ))( )

Here av (vertical acceleration), ah (horizontal acceleration), (roll angle) and   
˙ ̇ 

(roll angle acceleration) are all time varying. y,z are transverse and vertical

distance from the centre of gravity, g is gravitation acceleration and m is the

cargo mass.

Even though the different time varying motion components are linear with

respect to the wave height, the effective heel is strongly non-linear. The
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denominator N(t), which represent the normal force between cargo and ceiling,

becomes momentary very small when the vertical acceleration amplitude is

reaching g, even if the roll angle amplitude and acceleration is small. Fig.5.2

below shows a typical time series simulation in which the non-linear character of

effective heel due to large vertical acceleration is clearly visible.
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Fig.5.2 Example of effective heel variation

5.2  Effective heel level as criterion

Because of the non-linear character of effective heel, there is no direct way to

find the probability distributions of the peak values in an irregular sea (as is the

case for linear responses briefly described in Chapter 2). The only way to

establish a peak value distribution is to use extensive time-series simulation. In

a real-time surveillance system this would not be a realistic alternative because

of the necessary computational time.

In order to have a physical relevant and at the same time computable criterion

we suggest to use the effective heel level distribution instead of the peak
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distribution in the surveillance system. A criterion can then be formulated as the

percentage of time a certain level is exceeded. The level distribution can be

established with good accuracy by a much shorter simulation sequence than

would be necessary for the peak values, as long as the extreme levels are

disregarded. Furthermore, with known statistical correlation between the

components in the definition of effective heel, the probability of exceeding a

specific level can be calculated analytically without any simulation. An extensive

description of this method and a general description of the effective heel

(effective roll angle) concept will soon be published by Hua, /30/.

By assuming small angles of roll and resonant roll with natural roll frequency

n, the effective roll angle expression can be simplified to:

    
(t ) = arctan

ah (t ) + (g + n
2 ⋅z) ⋅ (t )

g + av (t ) − n
2 ⋅ y ⋅ ( t)

 

 
 

 

 
 

With a calculated joint probability density function f(av,ah, ) for vertical and

horizontal acceleration and roll angle, the probability of exceeding an effective

heel criterion value * can be written:

  

F( ≥ *) =    f (av ,ah, ) ⋅d
H

∞

∫
−∞

∞

∫
−∞

∞

∫ ah ⋅dav ⋅ d

with

    H = (g + av − n
2 ⋅ y ⋅ ) ⋅ tan * −(g + n

2 ⋅ z) ⋅

The following figures 5.3-5.4 show comparisons between simulated probability

distributions and distributions calculated with the aforementioned direct

expression

5  Effective heel 37



-30 -20 -10 0 10 20 30
0

0.02

0.04

0.06

0.08

0.1

 Effective roll angle ( deg ) 

The level distr.
by simulation

The level distr.
by the analytical
expression ( 8)

The peak value
distribution by
simulation

Fig.5.3 Example of simulated probability density functions for the level and
peak values of the effective heel at the bow of a Ro/Ro vessel. From /30/
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Fig.5.4 Comparison of standard deviation for level and peak values of the
effective heel as function of the significant wave height. From /30/
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6  The prototype – MONITOR

6.1  Features

The ambition during the work with the MONITOR prototype has been to create

a tool that is easy to use and that requires only a minimum of actions from the

user. As the system is intended to help avoid critical or dangerous situations, it

is of great importance that the user experience it as being logical, clear and

obvious. The system is highly modularised to gain flexibility, this makes it easy

to satisfy individual user preferences. It also allows for future updating and

expansion of the system without extensive reprogramming of the computer code. 

In its present version MONITOR can calculate the hydrostatic and

hydrodynamic properties of a ship with arbitrary loading. This is done during

the initialisation of the system. If then given a certain sea state, by manual

input or automatically evaluated from measurements, MONITOR can predict

wave induced responses of the ship, such as rigid body motions and

vertical/lateral accelerations at user defined points. It can also present an

expected effective heel angle. In addition, the system can predict the wave

induced vertical bending moment along the hull. The user can define his own

critical levels for all output, and have the system activate warnings when these

levels are exceeded.

The MONITOR software is also capable of some advisory services. The system

can assist the ship operator by indicating how different combinations of ship

speed and heading will affect the magnitude of ship responses.

6.2  Prototype configuration

The MONITOR prototype is built around 2 Macintosh computers, see fig. 6.1.

One computer controls the continuously performed measurements of the ship

motions, used to evaluate the sea state. The other computer runs the MONITOR

interface software which is the heart of the system and the platform for user

interaction. The two computers work fully separated.

When automatic operation of the system is requested by the user, the
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"MONITOR computer" pulls the data necessary to evaluate the actual sea state

from the "Measuring computer". This is done through the built in AppleTalk

communication facility.

MONITOR Computer
MONITOR Interface

Measuring Computer
LabView

AppleTalk

Bridge instruments

Meas. equipment

Fig.6.1 MONITOR prototype configuration

The "Measuring computer" includes a runtime version of the commercial

software system LabVIEW® /36/ to administrate the measurements of ship

motions. LabVIEW is a very powerful tool, offering many ways to customise the

measuring sessions. Different types of gauges may be used as well as different

procedures for processing the sampled data. The selection of gauges used for the

MONITOR prototype is just one example, but may be regarded as a minimum

configuration.

The computer used for the measurements must accept a NuBus card for GPIB-

communication. One accelerometer and one rate gyro (2-axis) are attached to the

computer via an analog/digital converter. The equipment is switched on at the

beginning of a voyage, and requires no further user input. The system measures
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vertical acceleration and the roll and pitch angle velocities. Some additional data

are pulled from the bridge instruments, such as ship speed and heading, wind

speed and direction, and the ship position. The collected data are processed every

two minutes, resulting in mean spectra for the measured motion components.

This is done using the latest block (8 series, 16 minutes) of sampled data, Fig.6.2.

Two data files reside on the computers hard disk. One file holds the calculated

mean spectra for heave, pitch, and roll, as well as the data read from the bridge

instruments. The other file holds a counter, used by the MONITOR-computer to

determine if the contents of the first file have changed. The files are updated

every time processing of the collected data has finished. 

The "MONITOR computer" is switched on by the user whenever information or

advice is needed. The computer runs the MONITOR interface software developed

at KTH, which is the link between the user and the MONITOR surveillance

system. See fig 6.3. The software works on all Macintosh models, but to achieve

sufficient performance when using the system, a computer having 68040-

processor is strongly recommended.

Speed Course Wind speed
Relative wind 
direction

Vertical Acceleration Roll Velocity Pitch Velocity
Sample serie 
no 1 with it's 
spectrum

 2

 3

 8

Mean spectras

Mean values 
of data 
transferred
from the 
navigational 
system

Fig.6.2 Data in a measurement block
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Fig.6.3. MONITOR interface, flowchart

The MONITOR software was designed by use of the THINK Pascal™ /37/

programming environment. The software is made up of a main administrating

part and several specialised modules. Object Pascal have been used for the

graphical modules, while the pure numerical routines were written using

traditional Pascal. The object-programming technique promotes a highly

modularised software code. The MONITOR interface modules have all well

defined edges or outer shells. Each module can therefore be subject to internal

changes without any impact on its surrounding. In the future new methods, or

improvements to existing ones, can be implemented easily. The design also

permits each installation to be unique, only those modules of interest to a
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specific user need to be included. This is accomplished with only minor changes

to the main administrating part of the software code.

Calculations of hydrostatic properties are performed using the algorithm from

the in-house program HYSS /31/. The hydrodynamic properties are evaluated

using SGENS /32/, which is based on strip theory according to Salvesen et al.

/33/. 

Evaluations of sea state are made according to Chapter 4 in this report

(described in more detail in /27/).The "effective heel" angle is calculated

according to Chapter 5, /30/.

6.3  The interface – operational overview

As mentioned earlier, the interface software consists of a number of modules.

Each module handles a specific task or functionality, such as ship rigid motions

or accelerations, and has its own separate window (Display type) to take care of

input and/or present output. In addition, there are several numerical tools built

in. These modules are never visible to the user, they are used internally to

perform different types of calculations.

The prototype interface supports the following modules:

Display type Function

Main Summary of vital readings and warnings. Advisory services.

Ship Input ship/loading condition and weight distribution type.

Output static stability.

Output flag hydrodynamic properties.

Sea State Input or evaluated sea state.

Motions Output rigid body motions: Heave, pitch, roll, sway, yaw.

Output relative motions: Slamming, green water on deck

Accelerations Input coordinates user defined points.

Output vertical and lateral accelerations at user defined

points.

Output "effective heel" angle at user defined points.

Strength Output wave induced vertical bending moment.

Warnings Input limit/threshold values for warnings.
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The display types and their functionality are described in detail in the Appendix.

The interface can run in either of two operational modes: Set Up-mode, which is

used during initialisation and manual operation, or Monitor-mode which is

available once the system is initialised. In Monitor-mode, the software evaluates

the sea state and predicts the selected ship responses automatically every two

minutes. 

As indicated, the system has to be initialised prior to use. During the

initialisation procedure the ships actual loading condition is defined by the user,

and calculations of hydrostatic and -dynamic properties are executed. This

procedure is described in the following section, Initialisation. 

When switched on, the MONITOR software will start up in Set Up-mode and

open one window each of the display types Main, Ship, Sea State and Motions.

These windows work a bit different from the rest of the available types. They

always appear as were they a set, they are "linked" together and they share their

data automatically. They form a subgroup called a Ship Set, which provides basic

functionality. A Ship Set permits the user to initialise the system, to input or

evaluate the sea state and to make predictions of rigid body motions and relative

motions according to table 6.1.

Windows of the remaining display types are initially not opened nor assigned to

any group. If the user wants to include predictions of accelerations or vertical

bending moment, or to define limit values and warnings threshold values for the

predicted responses, he has to open a window of each preferred type and link

them to a Voyage. A Voyage is a template for grouping. By linking one Ship Set

(always required) and one or more additional windows to the same Voyage a

larger group is defined, and internal communication between the windows in the

Voyage is set up. See fig 6.4.
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Open windows of Display typeDisplay type

Main

Ship

Sea State

Motions

Accelerations

Strength

Warnings

Acc 1

Strength 1

Warnings 1

Ship Set 1 Ship Set 2

Strength 2

Warnings 2 Warnings 3

Voyage 1

Ship Set 3

Voyage 2

Fig.6.4 Grouping by the use of Voyages

The Voyage-concept provides the following advantages:

• Windows of display types that require user input may be saved to

disk, i.e. Ship, Accelerations and Warnings. Windows of Ship type

are saved with their actual status, i.e. if calculations of static

stability and hydrodynamic properties are performed, the output

from these calculations will be included. This makes it possible to

have several prepared/precalculated windows available on disk as

files for immediate use. A Voyage may also be saved and opened

later ready to use. When operating on a Voyage, the software

handles all the linked windows. If the user for example opens a

saved Voyage, the software takes care of opening all the windows

linked to the specified Voyage.
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• To minimise the amount of time required to make the predictions,

it is beneficial to be able to exclude predictions not of interest.

• If the interface grows in the future, i.e. more functionality is

added, the above advantages will become increasingly important.

6.4  Initialisation

The system is initialised from the Ship Display, see fig 6.5, while running the

software in Set Up-mode. The initialisation procedure includes user input of a

few numeric values followed by calculation of hydrostatic (static stability) and

hydrodynamic properties (strip theory). The complete initialisation procedure

will take approximately 3 minutes on a Macintosh Quadra 700. When the

procedure is finished, the system is ready to predict ship responses.

Fig.6.5. Ship Display
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As mentioned earlier, the ship input as well as calculated output may be saved to

disk. Any number of pre-initialised load cases may be saved, making it possible

to reduce the time required for the initialisation procedure drastically. 

To perform the above calculations, the system will need more information than

the data given by the operator. This additional information is built in into the

system. The input can be defined either as Constant data or as Conditional

input. The Constant data do not change, and may therefore reside permanent in

the system. The Conditional input reflects the actual loading condition, and must

be supplied by the user during initialisation.

Constant data:

Ship geometry

Conditions for strip calculations, such as frequencies, headings, speeds.

Relative weight distributions

Conditional input:

The user has to input 5 numeric values defining the actual load case. Two input

modes are available, "Fixed Displacement"-mode and "Fixed Floatation"-mode.

The table below describes the different input sets as well as the output from the

calculation of hydrostatic properties.

Input mode: Input Output

Fixed Displacement Displacement

Longitudinal CG

Transverse CG

Vertical CG

Correction GM

Draught

Trim

Heel

GM

Corrected GM

GZ-curve

Fixed Floatation Draught

Trim

Heel

Vertical CG

Correction GM

Displacement

Longitudinal CG

Transverse CG

GM

Corrected GM

GZ-curve
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The output from the calculation of hydrodynamic properties describes the

response characteristics of the ship (transfer functions). The transfer functions

themselves are not presented, only a message indicating whether they are

calculated or not.

6.5 Usage

The MONITOR interface two operational modes are: 

• Set Up-mode,

which is used during initialisation and manual operation. The

user has to provide the sea state information himself, and

manually execute the calculation of expected responses. This

mode makes it possible to make predictions at any time, even

before the ship is at sea. 

• Monitor-mode.

This mode is fully automatic, and may be used whenever the

system is initialised. The actual sea state is evaluated based on

the measurements of ship motions, and the requested predictions

are performed based on this sea state.

If the operator wants to perform predictions of responses when not at sea, or

would like to check responses for a sea state different from the one suggested by

the software while running in Monitor-mode, Set Up-mode is selected. While in

this mode, the Sea State display allows the user to define his own sea state by

input of significant wave height and mean wave period. The resulting sea state

will be based on a standard 2-parameter Pierson-Moskowitz wave spectrum

model. To enable prediction of responses, the user also has to supply ship speed

and relative wave direction.

During Set Up, all input fields are enabled for editing, and all built in

calculations are executable as long as the required input is supplied. The Main

display and the advisory services are not active while running in Set Up-mode.

The Monitor-mode is fully automatic and requires no user input. The system
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uses the measured ship motions as basis for evaluation of the sea state. The

presented results should be regarded as suggestions, and may in certain cases

not describe the actual conditions in an acceptable way. By default, the system

assumes that the waves may be characterised as long-crested and that the

dominating incoming wave direction equals the direction of the wind relative to

the ship. This may not be true. The evaluation procedure is very sensitive, and it

is especially important that the assumed relative wave direction is correct.

Therefore possibilities to override the default wave direction and wave

characteristics are included to help improve the result of the evaluation. When in

Monitor-mode, the system does not make use of standard spectrum models to

describe the sea state. The evaluation procedure searches for the actual sea

spectrum based on the spectrum of the measured motions. The sea state is

updated every two minutes, and all requested predictions are updated

accordingly.

The Monitor-mode disables input and editing as well as several other operations,

to prevent from changes by accident. The Main Display is active, and presents a

summary of the information given in the other windows. This display serves as

the home base during automatic operation of the system. From the Main Display

the operator may access the advisory services.

Windows of type Sea State (Sea State Display) and all types that present output

based on sea state owns two separate sets of data, i.e. one for each operational

mode. This makes it possible to use a manual sea state in parallel to an

automatically evaluated, and to switch between Set Up and Monitor-mode for

comparison. The system will present the correct output in all displays, see fig

6.6.
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Operational modes

Set Up                                  MonitorDisplay type

Main

Ship

Sea State

Motions

Accelerations

Strength

Warnings Limit/threshold values

EvaluatedManual

Transferfunctions, geometry etc.

Bridge instr.

Meas. motionsUser input

Summary

User input

Fig.6.6 Operational modes, flow of data

Predictions of rigid body motions and relative motions (Motions Display) are

possible without the use of Voyages. To include predictions of accelerations and

effective heel angle (Accelerations Display), vertical bending moment (Strength

Display), or to be able to define limit values and warnings threshold values for

the predicted responses (Warnings Display), it is necessary to create a Voyage

and to link one window of each preferred display type to the Voyage. Windows of

type Acceleration need user input of point coordinates to work. The prototype

handles two points. The Strength windows do not require any input. It is

possible to have several windows of the same type and/or several Voyages open

at the same time. This allows the operator to compare predictions made for

different load cases or different sea states. 
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The MONITOR interface allows the user to define his own critical levels for all

output, and have the system activate warnings when these levels are exceeded.

This is done from the Warnings Display. All responses may be given limit values

and warning threshold values. The results from the predictions are presented as

significant values and maximum expected values during 1 hour, see fig 6.7 for an

example. If a limit value is supplied, the system compares the predicted

maximum response to the limit value, and presents the probable number of

events for the maximum value to exceed the limit value during 1 hour.

Fig.6.7 Example of calculated response, rigid body motions

To enable the warnings, it is necessary to input a warning threshold value in

addition to the limit value. Warning threshold values are given as number of

events during 1 hour. If supplied, the threshold value will be compared to the

calculated probable number of events described above. If the calculated value

exceeds the threshold value, the warning is activated. To supply a threshold

value but not a limit value has no effect.

For examples on how to use the interface, see the Appendix: Description of the

MONITOR prototype interface.

6.6 Advisory service

When Monitor-mode is selected, the advisory services built in are available from

the Main display. The ship operator may use this facility to get indications on

how to handle the ship to minimise responses.
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Fig.6.8. Advisory service display, heave motion selected

During Monitor-mode, the requested predictions are made for a matrix of speed-

heading combinations, actual speed ± 3 knots and actual heading ± 10 degrees.

The results form the basis for the advisory services. At any time the operator

may specify a certain response of interest, and have the system present a graph

showing the magnitude of the selected response as function of ship speed and

heading. The most favourable action to take is easily read from the graph, see

fig. 6.8.   
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7  Conclusions and further work

By this report we have tried to describe the possible advantages that can be

achieved with a seakeeping prediction system on board ships:

• To optimise the operation and safety with regard to wave-induced

effects

• To detect critical situations for events that cannot be identified

with experience solely

• To continuously survey the situation in which the ship is

operating and give warnings when risk levels exceed given limits

By building the prototype we have also shown that it is possible to make real-

time theoretical predictions, even with moderate computer power, and to

administrate the output in a way that can be directly used in a real operating

situation.

What is then further to do? In the first place, the system must be implemented

on board a number of ships in order to gain experience of the quality or

uncertainty of the predictions. This knowledge can then be used within the

system to improve the risk analysis and to calibrate and improve the calculation

procedures. We will also prepare to add on a few more general functions and

displays that have been found desirable in our discussions with ship owners.

This includes surveillance of static stability by measuring the roll frequency, and

theoretical predictions of combined wave-induced stresses in primary structural

members. However, the strategy for the future is to keep the system as a core on

which different tailored modes can be added and the displays can be configured

according to the specific needs of each ship. 

Within this project it has also been identified that wave prediction methods or

instruments are of vital importance in order to increase the overall precision of

on board seakeeping predictions. Progress in this field will indeed lead to large

future prospects for theoretically based systems of the kind we have described in

this report.
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General information

This appendix describes the MONITOR interface software, the different displays

as well as the menus and all menu items. It also gives some examples on how to

use the system.

The software is fully menu driven as any true Macintosh application. The user

controls the interface application by selecting appropriate commands from the

menus. In no case there will be any need for instructions to the software by

typing, except when the user wants to rename windows prior to saving them to

disk. If the user is familiar with the Macintosh environment, MONITOR will be

easy to understand.

The MONITOR software requires at least 6Mb of RAM-memory to run, which

means that a minimum of 9 Mb of installed RAM is necessary. A 68881/68882

floating point device is needed. The computer must have System 7.0 or a later

version of the system software installed. The interface is designed to fit a 14"

colour screen. The use of a larger screen is possible, but will not change the size

of the MONITOR software displays.

The software has two operational modes available, Set Up-mode and MONITOR-

mode. During MONITOR-mode input and editing are disabled, as well as most

menu commands except items in the Display and Monitor menus. This is to

prevent from changes by accident during automatic operation.

Displays, Windows and Ship Sets

In this appendix the terms Displays and Windows are used. Selecting a certain

Display type (Main Display, Ship Display etc.) gives the user access to all open

windows of that type, if any. If the user for example moves to the Strength

Display by selecting Strength from the Display Menu, he will be able to select

any of the open Strength windows from the Windows menu. If there are no open

Strength windows, the list in the Windows menu will be empty, and the screen

all white. In other words, by selecting a certain Display type, the user indicates

that he wants to work with windows of that type.
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Windows of Display types that accept input, i.e. Ship, Accelerations and

Warnings (Sea State windows excluded) may be saved to disk as files. The user

may rename the windows during the save operation to any name he prefers.

There may be several open windows of each Display type. Windows of the types

Main, Ship, Sea State and Motions work a bit different from the rest: they

always appear as were they a set, they are "linked" together and they share their

data automatically. They form a subgroup called a Ship Set. The user has to

perform certain operations on a Ship Set from the Ship Display, such as opening,

closing, saving or linking. The rest of the windows in the set will be handled

automatically.

Voyages

A Voyage is a template for grouping. If the user wants to include predictions of

accelerations or vertical bending moment, or wants to define limit values and

warnings threshold values for the predicted responses, he has to create a Voyage.

By linking one Ship Set (always required) and one or more additional windows to

the Voyage a larger group is defined, and internal communication between the

windows in the group is set up. 

A Voyage may be saved to disk and opened later ready to use. The user may

rename the Voyage during the save operation to any name he prefers. When

operating on a Voyage, the software handles all the linked windows. If the user

for example opens a saved Voyage, the software takes care of opening all the

windows linked to the specified Voyage.

If the user prefers predictions of vertical bending moment, a few steps of action

are required prior to the calculation of hydrodynamic properties during the

initialisation procedure: a Voyage including the Ship Set and a Strength window

has to be defined and type of weight distribution selected. If not done, the

Strength window will not work without re-initialisation. The system will remind

the user about this during the initialisation procedure.

It is possible to have several Voyages open at the same time.
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Warnings

The user may define his own critical levels for all output, and have the system

activate warnings when these levels are exceeded. This is done from the

Warnings Display. Limit values and warning threshold values may be assigned

to all predicted responses. If a limit value is supplied, the system compares the

predicted maximum response to the limit value, and presents the probable

number of events for the maximum value to exceed the limit value during 1

hour. 

To enable the warnings, it is necessary to input a warning threshold value in

addition to the limit value. Warning threshold values are given as Number of

events during 1 hour. If supplied, the threshold value will be compared to the

calculated probable number of events described above. If the calculated value

exceeds the threshold value, the warning is activated. To supply a threshold

value but not a limit value has no effect.
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Menus

The interface supports the following menus:

File Edit Voyage Display Windows Calculate Monitor Special

File menu:

NOTE: The File menu is disabled during MONITOR-mode.

New: Opens a new, empty window of the active

Display type. If New is selected from the Ship Display,

a complete Ship Set will be opened. New is not

available from Main, Sea State or Motions Displays.

Open...: Opens a standard Finder Open File dialog

and displays all files of the active Display type. The

user may select a file to open, or cancel the operation.

If Open is selected from the Ship Display, a complete

Ship Set will be opened. Open is not available from

Main, Sea State or Motions Displays.

Close: Closes the active window. Close may also be

executed by clicking in the close box of the window. If

Close is selected from the Ship Display, the complete

Ship Set will be closed. Close is not available from

Main, Sea State or Motions Displays.

Close All: Close all open windows except those linked to an open Voyage.

Save: Save changes to an already saved window without the possibility to

rename. Save is not available from Main, Sea State or Motions Displays.
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Save As...: Save window to disk. Opens a standard Finder Save File dialog. The

user may rename the window prior to saving it, or cancel the operation. Save As

is not available from Main, Sea State or Motions Displays.

Revert to Saved: Not implemented.

New Voyage: Open a new, empty Voyage.

Open Voyage: Opens a standard Finder Open File dialog and displays all

Voyages on disk. The user may select a Voyage to open, or cancel the operation.

Open Voyage will open all linked windows (files).

Close Voyage: Close the active Voyage. Close Voyage will close all linked

windows.

Save Voyage: Save changes to an already saved Voyage without the possibility

to rename. Save Voyage will save changes made to all linked windows.

Save Voyage As...: Save Voyage to disk. Opens a standard Finder Save File

dialog. The user may rename the Voyage prior to saving it, or cancel the

operation. Save Voyage As will save all linked windows.

Page Setup...: Not implemented.

Print...: Not implemented.

Quit: Quit the application.
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Edit menu:

The items in the Edit menu have common Macintosh functionality. 

NOTE: The Edit menu is disabled during MONITOR-mode.

Voyage menu:

NOTE: The Voyage menu is disabled during MONITOR-mode.

Show/Hide Voyage: Show or hide a floating window

presenting the windows linked to the active Voyage. Hide

Voyage may be executed by clicking in the close-box of the

floating window.

Reset Voyage: Not implemented.

Link File: Link active window to the active Voyage.

Unlink File: Unlink active window from the active Voyage.

List: List of open Voyages. The user may select any Voyage from list. The

selected Voyage is checked and called the active Voyage. 
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Display menu:

Item: Select Display type. The selected type is checked

and called the active type.

Windows menu:

List of open windows of active Display type. The user may select any window

from list. The selected window is checked and called the active window.

Calculate menu:

NOTE: The Calculate menu is disabled during Monitor-mode.

All Hydro Properties: Calculate hydrostatic and

hydrodynamic properties. Enabled from Ship

Display.

Hydrostatic: Calculate hydrostatic properties.

Enabled from Ship Display.

H y d r o d y n a m i c : C a l c u l a t e h y d r o d y n a m i c

properties. Enabled from Ship Display.

All Responses: Predict all requested responses. Enabled from Sea State

Display.
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Motions: Predict rigid body motions and relative motions. Enabled from Sea

State and Motions displays.

Accelerations: Predict accelerations and effective heel angles. Enabled from

Sea State and Accelerations displays.

Dynamic Strength: Predict vertical bending moment. Enabled from Sea State

and Strength displays.

Monitor menu:

NOTE: The Monitor menu is enabled only from the Sea State Display.

Set Up: Select Set Up (manual) mode.

Monitor: Select Monitor (automatic) mode.

Special menu:

NOTE: The Special menu is disabled during Monitor-mode.

Help: Not implemented.

Sound: Not implemented.
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Display Types

The interface supports the following Display Types:

MAIN SHIP SEA STATE MOTIONS

ACCELERATIONS STRENGTH WARNINGS

The topmost part of the screen will have a similar layout regardless of selected

Display type. This section of the windows is called the Header Section. Besides

the Display type, this section presents the name of the ship, time and date and

one or two more items:

Link Status:

Indicates whether this window is linked to a Voyage or not.

Warnings:

Indicates whether the Warnings Active-box in linked Warnings window is

checked or not.

The following pages describes the different displays. In the figures, certain areas

are framed and numbered. This is done for easier identification while reading

the appendix. 
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Main Display

1

2

3

4

5

NOTE: This Display type is available only during Monitor-mode.

Ship Section, 1

Output from bridge instruments.

Sea State Section, 2

Output copied from the Sea State window of Ship Set. The wave direction is

presented as relative to the ship, SB(+)/PS(-) 0-180 deg, where 0 deg is head

waves.

Wind Section, 3

Output from bridge instruments. The wind direction is presented as relative to

the ship, SB(+)/PS(-) 0-180 deg, where 0 deg is head wind.
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Warnings Section, 4

Summary of warnings. The warnings are activated if one or more warnings in

the generic displays are activated.

Advice Section, 5

The graph is initially blank. By pressing the Advice... button, the user may

select any predicted response included in active Voyage or active Ship Set. The

magnitude of the selected response will be presented in the graph as function of

ship speed and heading. The Clear Advice button will empty the graph.
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Ship Display

1

2

3

4

1

2

3

4
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Ship Input Section, 1

Input mode:

The user may select Fixed Displacement or Fixed Floatation mode. The input set

as well as the output set from the hydrostatic calculations will change to reflect

the selection made, see the figures.

Input items:

Fixed Displacement mode, input:

Displacement: Displacement in metric tons

Long. CG: Longitudinal CG, Positive fwd Lpp/2

Transv. CG: Transverse CG,  Positive to PS from CL

Vert CG: Vertical CG, Positive upwards from keel

Correction GM: Correction for free surfaces

Fixed Floatation mode, input:

Draught: Draught at Lpp/2

Trim: Total trim, Positive trim by the aft

Heel: Static heel angle, Positive to SB

Vert CG: Vertical CG, Positive upwards from keel

Correction GM: Correction for free surfaces.

Dynamic Strength Input Section, 2

This section is activated if a Voyage including the active Ship Set and a Strength

window is defined.

Weight distribution:

To perform predictions of vertical bending moment, the weight distribution type

must be selected prior to calculations of hydrodynamic properties. The user may

select Full Load or Ballast type distribution.
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Output Section, 3

Calculated Ship Properties:

The results from hydrodynamic calculations are indicated by two flags. The

second flag tells whether weight distribution was selected prior to calculations or

not.

Hydrostatic output items:

Fixed Displacement mode, output:

For Draught, Trim and Heel, see Fixed Floatation mode, input.

GM: Metacentric height.

GM': Metacentric height, corrected for free surfaces.

GZ: Righting lever at different heel angles.

Fixed Floatation mode, output:

For Displacement, Long. CG and Transv. CG,

see Fixed Displacement mode, input.

For GM, GM' and GZ, see Fixed Displacement mode, output.

Warnings Section, 4

A threshold value may be assigned to the GM' output. The warning will be

activated if the hydrostatic calculations result in to low GM'.
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Sea State Display

2

1

3

2

1

3
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Operating Mode Section, 1

During Set Up-mode, only Manual Operating mode is available. The input to the

Sea State Section must be supplied by the user.

During Monitor-mode, Auto or Interrupt Operating modes are available. If Auto

mode is selected, no input is required or possible. The user may override the

default wave characteristics (long-crested sea) and wave direction (equals wind

direction) if Interrupt is selected. To use manual wave direction, the Use manual

input box must be checked. On return to Auto mode, the user input will be used

during evaluation of the sea state.

Sea State Section, 2

Input or output depending on software mode, see Operating Mode Section. 

Wave characteristics:

If Interrupt is selected, the user may override the default (long-crested sea)

characteristics. On return to Auto operating mode, the user selection will be

used.

Ship speed:

Read from bridge instruments or user input depending on operating mode.

Wave direction:

Read from bridge instruments or user input depending on operating mode. The

wave direction is given as relative to the ship, SB(+)/PS(-) 0-180 deg, where 0 deg

is head waves.

Wave period:

Calculated value or user input depending on operating mode.

Wave height, significant:

Calculated value or user input depending on operating mode. 

Wave height, expected maximum during 1 hour:

Output during Monitor mode.

Warnings Section, 3

A threshold value may be assigned to the output of expected maximum wave

height during 1 hour. The warning will be activated if the sea state evaluation

result in a to high value.
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Motions Display

1

32

Sea State Info Section, 1

Indicates the type of sea state (Manual or Auto) used for the presented

predictions. If Auto sea state, the time period for measurements is shown.

Predicted Motions Section, 2

Rigid body motions:

For heave, pitch, roll, sway and yaw the predicted responses are presented as

significant values and expected maximum values during 1 hour, single

amplitude. 

If a limit value is supplied (Warnings Display), the probable number of events for

the calculated maximum response to exceed the limit value during 1 hour will be

calculated.

Relative motions:

The relative motions Bow slamming and Green water on deck are presented as

the probable no of events during 1 hour. No limit values are required.
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Warnings Section, 3

Threshold values may be assigned to the predicted output (Warnings Display). A

warning will be activated if the calculated probable number of events for the

maximum response to exceed the limit value during 1 hour is higher than the

threshold value.

Accelerations Display

1

2
3

4

Sea State Info Section, 1

Indicates the type of sea state (Manual or Auto) used for the presented

predictions. If Auto sea state, the time period for measurements is shown.
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Points Input section, 2

The Acceleration windows require user input of point coordinates to work. Two

points may be defined. The points will be used for predictions of accelerations as

well as effective heel angles.

Point #:

Input point name. Not required.

Long:

Point longitudinal coordinate. Measured from AP, positive fwd.

Transv:

Point transverse coordinate. Measured from CL, positive at PS.

Vert:

Point vertical coordinate. Measured from keel, positive upwards.

Predicted Accelerations Section, 3

Accelerations:

For valid points, predicted as significant values and expected maximum values

during 1 hour, single amplitude. 

If a limit value is supplied (Warnings Display), the probable number of events for

the calculated maximum response to exceed the limit value during 1 hour will be

calculated.

Effective heel angles:

If valid points are assigned limit values (Warnings Display), the predicted total

time for the effective heel angles to exceed the limit values during 1 hour are

presented.

Warnings Section, 4

Threshold values may be assigned to the predicted output (Warnings Display). A

warning will be activated if the calculated probable number of events, or

predicted total time, for the maximum response to exceed the limit value during

1 hour is higher than the threshold value.
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Strength Display

1

2

3

Sea State Info Section, 1

Indicates the type of sea state (Manual or Auto) used for the presented

predictions. If Auto sea state, the time period for measurements is shown.

Predicted Dynamic Loads Section, 2

Ship Weight distribution:

Indicates the type of weight distribution used for the predictions.

Largest wave induced Vertical Bending Moment:

For the highest loaded section, predicted vertical bending moment is presented

as significant value and expected maximum value during 1 hour, single

amplitude. If a limit value is supplied (Warnings Display), the probable number

of events for the calculated maximum response to exceed the limit value during 1

hour will be calculated. The section number of the highest loaded section is

presented.
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Longitudinal distribution VBM:

The predicted significant values are presented at 10 sections along the hull.

Warnings Section, 3

A threshold value may be assigned to the predicted output of largest vertical

bending moment at section (Warnings Display). The warning will be activated if

the calculated probable number of events for the maximum response to exceed

the limit value during 1 hour is higher than the threshold value.
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Warnings Display
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NOTE: The Warnings windows have 2 pages. Use the Page buttons at the bottom

to toggle between pages.

Input Section

The input section has separate parts for each display type. The user is not

required to supply input to all input fields, only those of interest. 

Warnings Active boxes:

Use or Do not use the supplied input. The status of this check boxes are shown in

the headers, Warnings item, in other windows.

Limit values Input:

For most items it is possible to input a limit value. If a limit value is supplied,

the probable number of events for the calculated maximum response to exceed

the limit value during 1 hour will be calculated.

Warnings Threshold values Input:

A threshold value may be assigned to all items. If it is possible to input a limit

value for the same response component, it is of no use only supplying the

threshold value. The warning will be activated if the calculated probable number

of events for the maximum response to exceed the limit value during 1 hour is

higher than the threshold value.

In those cases limit values are not possible, the warnings will be activated when

the calculated output is higher than the threshold (for GM' lower).
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Examples

These examples will guide you through the MONITOR interface. 

To start the application, double-click on the MONITOR icon or select the icon

and execute Open from the File menu.

The application will always start up in Set up-mode and open one empty Ship

Set, i.e. one window each of the types Main, Ship, Sea State and Motions. 

The first thing to do is to initialise, i.e. prepare for predictions. This may be done

in either of two ways, by opening an earlier saved Ship Set or Voyage that

includes a Ship Set, or by doing it from the very beginning.

The first example describes both alternatives.

Set Up mode, Initialisation, (manual operation)

1) Start the application according to the above instructions.

2) Try the Display and Windows menus. You are probably in the Ship display at

the moment. Try to select the Sea State and Motions displays from the Display

menu. Pull down the Windows menu. Note that the names of the windows are

Ship Set 1 in all these displays.

Try to move to the Accelerations display. The screen becomes all white, which

means that there are no open windows of type Accelerations. If you pull down

the Windows menu it will be empty.

3) Return to the Ship display (select Ship from the Display menu). Locate the

Input Mode buttons in the top left corner. Examine the two alternative options,

and select one of them.

Fill in the blue input fields to the left. If you try to pull down the calculate menu

before you have supplied all the values, you will not be able to execute any

calculations. Do not execute any calculations yet.

4) Now save the window. Select Save or Save As... from the File menu. A dialog

will open that lets you specify the name you want for the file, and select a folder

or place on the hard disk to put it.

Appendix:  Description of the MONITOR prototype interface A25



5) Select Close All from the File menu. This command closes all open windows

regardless of their type. Only those linked to open Voyages will remain open, but

we do not use any Voyage at the moment. If you move around to the different

Display types, you will only see blank pages.

6) Return to the Ship display. Select Open from the File menu. A dialog will

open. Try to find the file you just saved, select it and click open. You will now see

your saved Ship Set, but this time it is named as the file.

7) Pull down the Calculate menu. If all input values are supplied, you will be

able to execute All Hydro Properties or Hydrostatic. Select All Hydro Properties.

This command executes both the hydrostatic and the hydrodynamic calculations.

You will have to wait a few minutes for the calculations to finish. When

complete, the initialisation is ready.

8) Now try Save again. This time you save the ship set including the output. The

next time you open it, the Ship Set will be ready for predictions.

9) Move to the Sea State display. You now have the choice of continue operating

in manual mode (Set Up) or selecting Monitor mode. This is done from the

Monitor menu.

10) Let's stay in Set Up-mode for a while. The Sea State windows accept input

during this mode. Try to input some figures and pull down the Calculate menu.

If all input fields are filled, you will be able to execute All responses. Do so.

11) Select the Motions display. You should now have some results ready. The

output fields for Predicted number of events... will be blank. To get results in

these fields, you have to supply limit values, and this is done from the Warnings

display.

12) Move to the Warnings display. Select New from the File menu to get a new,

empty window. Locate the Motions part on page one. Fill in some of the Limit

value fields and check the Warnings Active box. Return to the Motions display

and note that nothing has happened here. This is because the Warnings

windows, as also the Accelerations and Strength windows, must be included by

the use of a Voyage.

A26



13) Select New Voyage from the File menu. The Voyage menu will be enabled.

Pull down the menu, and you will see all open Voyages at the bottom. The one

you are working with is checked.

14) The next step is to link your Warnings window and Ship set to this Voyage.

Move to the Warnings display. Select Link File from the Voyage menu. The Link

Status indicator in the top right corner will state Linked.

15) Now move to the Ship display. When you want to link a ship set, this must be

done from here. Select Link File from the Voyage menu. All the windows in the

ship set will now indicate that they are linked.

16) Move to the Motions display. The Warnings indicator in the top right corner

reflects the status of the Warnings Active check box in the linked Warnings

window. If you did input some limit values earlier, the predicted results are

cleared.

17) Pull down the Calculate menu and execute Motions. The command All

responses only works from the Sea State display. When the predictions are

made, you will see the number of expected events... for those motion components

you have given limit values.

18) To have the Warnings work, you must supply the Warnings threshold values

in addition to the limit values. Move to the Warnings display.

19) Input threshold values for all motion components. Then return to the

Motions display. The warnings for those components you have given both limit

and threshold values should work now, they are either blue or red.

20) If you return to the Warnings display and uncheck the Warnings Active box,

the input set given will not be used. Move to the Motions display. The Warnings

indicator in the top right corner will state Not active.

21) Now select Save Voyage from the File menu. You will see an alert telling that

all windows linked to the Voyage you are trying to save must be saved first.

Click OK.
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22) As the ship set is already saved, it requires no additional saving. But the

Warnings window has to be saved. Give it a name and save it, and then save the

Voyage.

23) Now select Close Voyage from the File menu. This command closes the

Voyage and all its linked windows. You should not have any open windows by

now.

24) Select Open Voyage. Try to find the name of the Voyage you just saved and

click open. When you open a voyage, all the linked windows will be opened with

it, so this action will bring you the ship set as well as the Warnings window back.

25) You have now tried most of the basic functions of the MONITOR interface in

manual mode. The Accelerations and Strength windows work just like the

Warnings windows, they have to be linked to function.

If you want predictions of vertical bending moment (Strength display), you have

to create your Voyage and include the Strength window and Ship set, and select

the preferred weight distribution type in the Ship display before you execute the

hydrodynamic calculations.

26) Select Quit from the File menu. This terminates the application.

Monitor mode (auto operation)

1) Start the MONITOR application and open the Voyage you have prepared. You

may execute Close All from the File menu to close all windows that does not

belong to the Voyage. 

2) Move to the Sea State display. Pull down the Monitor menu (this menu can

only be handled from here) and select Monitor. The program now reads the files

on the hard disk of the computer administrating the measurements of ship

motions. It then tries to evaluate the sea state based on these measurements.

3) When the sea state is calculated, all predictions you have included in your

Voyage will be performed. Right now this means that Motions will be predicted

based on the evaluated sea state.
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4) When in Auto mode, you have to judge the validity of the sea state suggested

by the program. If you are in the Sea State display, take a look at the assumed

wave direction. If the value is bad compared to the actual direction, the

calculated sea state will probably be poor. 

5) You may use manual input for the wave direction. Select Interrupt in the top

left corner. This will allow you to input a manual value in the wave direction

field. Check the Use manual input box to the right of the input field.

6) You may also change wave characteristics by checking the appropriate box.

7) If you switch to Auto again, the program will use your manual input and

recalculate the sea state. The result should improve if the first assumptions were

poor.

8) You may at any time switch to manual (Set Up) mode. It is possible to input a

manual sea state and make manual predictions in parallel to the automatic

predictions made in Monitor mode. All output windows have two separate sets of

data, i.e. one for manual sea state and one for auto sea state.

9) While in Monitor (Auto) mode, the Main display is available. Select it from the

Display menu. The Main display presents a summary of the information given in

the other windows. 

10) From the Main display you use the Advisory service. Press the Advice button

and select any response of interest. The graph will show the magnitude of the

selected response as function of wave direction and ship speed. 

11) Note that many menus are disabled during Monitor-mode. You are not able

to edit any values, execute any calculations or change the content of your

Voyage. You can not even quit the application.

12) Move to the Sea State display. Select Set up, and then select Quit to

terminate the program.
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